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1
Introduction 

The GNAV Pro Quick Reference Guide provides a brief overview of GNAV 
Pro and provides step-by-step instructions for the most commonly used 
procedures. 

The following topics are included in this chapter:

Chapter Topics • About GNAV Pro
• How This Guide is Organized
• Using This Guide
• Navigating GNAV Pro
• GNAV Pro online Help

About GNAV Pro

Global Navigator Pro (GNAV Pro) consists of GNAV Pro, Report Designer, 
and System Configuration. GNAV Pro connects to the Global Navigator 
Server. This chapter provides an overview of GNAV Pro.

Global Navigator MIS provides customers with the information required 
to evaluate and tune the performance of a call center. GNAV Pro is a 
visual interface to the Global Navigator MIS which allows customers to 
view the incoming call activity on an up-to-the-second basis, as well as 
the status of the agents. In the real time views, the following 
information can be displayed:

• The quantity of calls that are queued to all splits, an individual split or 
an individual team.

• The quantity of announcements to which queued calls have been 
connected.

• The total number of calls presented to the ACD system since the start 
of the MIS day.

• The average time to answer calls since the start of the MIS day.
• The longest waiting caller in queue at the current moment.
• The percentage and count of callers who have abandoned before 

being connected to an announcement, after being connected to an 
announcement, or while receiving ring back tone, since the start of 
the MIS day.

• The state that each agent is in currently and the duration of time that 
the agent has been in that state.
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• The number of agents currently in each state for the system, teams, 
splits, and administrative groups.

• Detailed statistics for a specific state for the system, teams, splits, 
and agents.

How This Guide is Organized 

Chapter 1
Introduction

This chapter provides a brief description of GNAV Pro, along with an 
overview of the contents of this manual, the document conventions 
used, and keyboard shortcuts available in GNAV Pro. Also included is an 
overview of the GNAV Pro Online Help.

Chapter 2
Requirements and Installation

This chapter describes the requirements and the steps necessary to 
install and uninstall GNAV Pro. 

Chapter 3
System Configuration

This chapter provides an overview of the GNAV Pro System 
Configuration, including how to access the System Configuration window 
and a brief description of how to configure and maintain entities.

Chapter 4
Using GNAV Pro

This chapter provides an overview of the GNAV Pro windows and icons.

Chapter 5
User Configuration

This chapter provides an overview of user profile configuration and 
maintainence.

Chapter 6
Real Time Statistics Views

This chapter shows you how to view real-time statistics. 

Chapter 7
Reports

This chapter provides an overview of GNAV Pro reporting capabilities.

Chapter 8
Configuring Wallboards

This chapter provides an overview of wallboard configuration and 
maintainence.

Appendix A
Database Table Layouts

This appendix describes meta-data of the tables used in GNAV Pro, 
including field descriptions and data sources. 
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Using This Guide 

This guide is designed to make GNAV Pro easy to use. This guide 
contains examples of screens and step-by-step instructions for the 
procedures you need to perform.

Document Conventions 
This guide uses the following document conventions listed in Table 1-1:

Table 1-1  Document Conventions 

Procedures 
Step-by-step instructions are numbered. Simply follow the numbered 
steps to perform the desired function.

Sometimes in step-by-step instructions, you will have more than one 
option to complete the task. These options are presented as shown in 
the following example:

Step  1 Do one of the following to add a new employee to the Employee 
directory:

—Select the desired employee from the Name field and click Add.

When you see It means Example

Boldfaced 

• Field names
• Button names
• Drop-down list names

• Commands, keywords, or 
other user input

Enter the ID in the Name field.
Click Save.
Select the names from the 
Employees drop-down list.
Enter login admin at the command 
prompt. 

Capitalized 

• Menu names
• Window names

• Dialog box names

From the File menu, choose Save.
From the Directory window, select 
Edit > Modify. 
Click OK to save and close the 
Account Properties dialog box.

Menu > Submenu
(boldfaced font)

• Menu paths Select Edit > Modify.

CTRL+S
CTRL+Shift+S

• Shortcut keys Press CTRL+S to save your changes.

F2 • Function keys Press F1 to access the online help. 

Click
Right-click

• Click the left mouse button
• Click the right mouse button

Click OK to save your changes. 
Right-click and select Delete from the 
shortcut menu.
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—Double-click the desired employee from the Name field.
—To select all of the available names, click Add all.

Navigating GNAV Pro 

You can use either the keyboard or mouse to navigate in GNAV Pro. 

General Keyboard Conventions 
The keys that can be used for navigation in this application are listed in 
Table 1-2.

Table 1-2  Keyboard Conventions

Mouse Conventions 
You can use the mouse to perform the following operations in this 
application:

• Add an entity to a new group by dragging the entity from one group to 
a desired group. For example, dragging an agent from Agent Group 1 
to Agent Group 2 adds the agent to Agent Group 2.

• Right-click on any entity to modify the properties of that entity or 
delete the entity.

• Double-click on a view to open that view and configure the 
parameters. 

• Double-click on a report to open the report and configure the 
parameters. 

• Double-click on a report template to generate the report.
• Moving a mouse over entities, status bar descriptions, and graph 

values displays brief information about the item.

Key Action
Arrow keys Scrolls among options within a menu or field.

Backspace Erases the character to the left of the cursor. 

Enter Accepts a selection or field entry. 

ESC Exits the current screen or action and moves to the previous screen 
or action.

Tab Moves forward through fields and options.

Shift+Tab Moves backward through fields and options.

CTRL+Tab Moves forward through tabs.

CTRL+Shift+Tab Moves backward through tabs.
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GNAV Pro online Help

The GNAV Pro online Help is contained on the GNAV Pro CD and is 
automatically installed during the installation of the GNAV Pro program. 
To access the GNAV Pro Online Help, do the following:

Step Select Guide from the Help menu in any of the GNAV Pro windows.

Navigating GNAV Pro Help
GNAV Pro Help topics are grouped according to function and content 
within three tabs: Contents, Index, and Search.

Contents Tab
The Contents tab is intended to be used as an online Table of Contents. 

• Click a Closed Book icon to display all the help topics contained within 
the book.

• Click an Open Book icon to close the book and all of its help topics.
• Click a Help Topic icon to display the specific help topic window 

related to the icon.

Index Tab
The Index tab enables you to search for a help topic by using a keyword. 

Search Tab
The Search tab enables you to perform a full-text search for Help topics.   

Printing Help Topics
GNAV Pro online Help topics can be printed from within the browser you 
are using to view the Help file. Printing procedures are different among 
browsers and are affected by browser configuration. Please follow the 
instructions provided with your particular browser.
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2
Requirements and Installation

This chapter describes the requirements and the steps necessary to 
install, uninstall, and upgrade GNAV Pro. The following topics are 
included in this chapter:

Chapter Topics • GNAV Pro Hardware Requirements
• GNAV Pro Software Requirements
• Installing GNAV Pro
• Uninstalling GNAV Pro

GNAV Pro Hardware Requirements

Table 2-1 lists the hardware configuration required to operate GNAV Pro.

Table 2-1  Hardware Requirements

Components Minimum Recommended
Memory (RAM) 364 MB 512 MB

Processor Pentium III 900 MHz Pentium III 1.2 GHz

Available Hard Disk 
Space 100 MB 100 MB

Video
800 X 600 Resolution 

 256 Colors
60 Hz Refresh Rate

1024 X 768 Resolution
True Color (32-bit)

60 Hz Refresh Rate

CD ROM Drive 4X CD ROM is acceptable for all platforms.

Network Interface 
Card (NIC) with 

network connection

10 Mbps or 100 Mbps NIC is required for all platforms.
Unrestricted network access to the Global Navigator Server is required.

MS Mouse Two-button mouse is required.
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GNAV Pro Software Requirements

Table 2-2 lists the software configuration required to operate GNAV Pro.

Table 2-2  Software Requirements

Installing GNAV Pro

The following procedure guides you through the installation of GNAV 
Pro. The Setup program consists of a series of dialog boxes that supply 
default answers to questions regarding the installation of files to your 
hard disk.

Step  1 Insert the GNAV Pro installation CD into the computer’s CD-ROM drive. 
On most computers, setup will automatically start when the CD is loaded. 
If Autorun is not enabled on the computer, then do the following:

—After inserting the GNAV Pro installation CD into the computer’s CD-
ROM drive, open Windows Explorer and double-click the CD-ROM 
drive icon.

—In the CD-ROM file list, double-click the Setup.exe file.

The Welcome dialog box displays (Figure 2-1).

Component Requirement

Operating System
Windows 2000 with Service Pack 4 or higher

Windows XP with Service Pack 1

Network Connection A properly installed and configured network connection to the Global 
Navigator Server, version 6.0 or higher.

Internet Browser
A properly installed and configured version of Internet Explorer 5.0 or higher, 
or Netscape Navigator 6.0 or higher, is required to access online Help. Java 
applet support must be enabled and the browser must be configured as your 
system default browser. 

IMPORTANT

The GNAV Pro version must match the Global Navigator Server version with which it 
will communicate. Installation of the Server and GNAV Pros should be conducted 
simultaneously.

IMPORTANT

Be sure to close all Windows programs and disable any virus protection applications 
before beginning the Gnav Pro Setup program. Depending upon your PC’s 
configuration, the computer may need to restart after the installation completes. The 
Windows Installer performs this action automatically at the end of the installation 
process.
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Figure 2-1  Welcome dialog box

Step  2 Click Next and follow the on-screen prompts in the Setup program to 
continue the installation. The Setup Server Connection dialog displays 
(Figure 2-2).

Figure 2-2  Setup Server Connection

Step  3 Enter the IP address for the Global Navigator Server and press Next. 
When the Setup program finishes installing GNAV Pro on your computer, 
the Setup Complete dialog box displays (Figure 2-3).
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Figure 2-3  Setup Complete dialog box 

Step  4 Click Finish to exit the Setup program.

Uninstalling GNAV Pro

You can remove the GNAV Pro from your computer using the Add/
Remove Programs control panel. Due to differences in the control 
panel’s location between Microsoft Windows versions, consult your 
computer’s online help for specific instructions.

To remove the GNAV Pro application, do the following:

Step  1 Locate the Add/Remove Programs control panel.

Step  2 Double-click the Add/Remove Programs icon. The Add/Remove 
Programs Properties window displays.

Step  3 Select GNAV Pro from the list of programs and click the Add/Remove 
button.

Step  4 When asked to verify that you want to uninstall GNAV Pro, click Yes to 
begin the uninstall.

Step  5 Click the OK button. The uninstall is now complete.

NOTE

After the uninstall is complete, a dialog displays. If there are elements that could not 
be removed, then a Details button displays. The GNAV Pro folder will not be 
removed automatically but this can be performed manually. In default installations, 
this will be under the Program Files / NEC folder. If you are reinstalling another 
version of GNAV Pro, then removing the directory is not necessary. 
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During the installation of previous versions of GNAV Pro, the Java 
Runtime Environment was installed on your PC (if it was not present 
already) to support the operation of GNAV Pro. Java may also be used 
by other applications on your PC. 

IMPORTANT

If you choose to remove the Java Runtime Environment that was installed during the 
GNAV Pro installation, first call NEC’s National Technical Assistance Center (NTAC) 
to learn the correct version to remove.
Repeat the uninstall steps and when you reach step 3, select the proper Java 
Runtime Environment version as specified by NTAC. 
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3
Configuring GNAV Pro

This chapter provides an overview of entities and other MIS 
configuration settings in GNAV Pro.

The following topics are included in this chapter:

Chapter Topics • What are Entities?
• Accessing System Configuration

What are Entities? 

Entities are configurable items that represent elements of the GNAV Pro 
system, such as an agent, pilot, or split. Entities are generally 
standalone elements that likely include a mixture of items created by 
the system without user intervention and items created by the user. For 
example, one entity can be an agent group created by a user while 
another is an extension defined in the PBX. 

System entities are created automatically by GNAV Pro without user 
intervention. Table 3-1 lists the types of system entities. 

Table 3-1  System Entity Types

NOTE

For detailed instructions on configuring GNAV Pro, refer to the GNAV Pro Online 
Help.

Entity Type Description

Agent A person who logs on to a phone to process ACD calls. An agent: 
can service multiple splits, answering calls from any or all splits. 

Admin Group
A set of Agents grouped together based on different conditions, 
such as experience level or skills. Admin Groups allow the system 
manager to gather statistics on agents in different splits.
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Accessing System Configuration

Use the following steps to acess the System Configuration:

Step  1 From the Start Menu, select Programs > NEC GNAV Pro > System 
Configuration. The login dialog displays.(Figure 3-1). 

Figure 3-1  GNAV Pro Configuration Login dialog box

Step  2 Enter your user name,  password, and server IP, then click OK. The 
System Configuration window displays (Figure 3-2).

Extension

A telephone generally used for ACD work. There are three types of 
extensions referred to in GNAV Pro: analog, digital and business. 
• Analog and digital extensions allow agents to log on and receive 

ACD calls, as well as make and receive calls on a secondary 
(PBX) line.

• Business extensions are extensions on a PBX that are not used 
to handle ACD calls.

Node A physical switch and all entities related to that switch, including its 
agents, splits, pilots, trunks and extensions. 

Pilot

A number used to receive all ACD calls. Calls coming to a pilot are 
automatically queued. The call follows pre-programmed steps 
called a CCV (Call Control Vector).The call, while associated with 
the pilot, can be presented to multiple splits before being passed to 
an agent for final handling.

Split
A queue through which ACD calls are distributed to agents logged 
on to that split. Splits generally are used to handle calls of a like 
type. For example, you can set up a split that only handles sales 
calls or support calls.

Team A set of Splits grouped together to gather statistical information.

Trunk A single incoming or outgoing line from the PBX, uniquely defined 
with a route and circuit number.

Trunk Group A group of trunks based on route numbers.

Entity Type Description
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Figure 3-2  System Configuration window

The System Configuration window provides access to the configuration 
options for the server and entities. The System Configuration window 
contains the menus, toolbar, status bar, and the tree view that lists the 
Entities used in GNAV Pro.

Tree View The Tree View displays in the left pane of the System Configuration 
window and contains nodes for Site, System, Splits, Teams, Agents, 
Admin and Node. To configure specific entities in GNAV Pro, make the 
appropriate selection from the Tree View.

NOTE

For detailed instructions on configuring GNAV Pro, refer to the GNAV Pro Online 
Help.
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4
Using GNAV Pro

GNAV Pro allows users to access real-time statistics, generate reports, 
and configure various aspects of Global Navigator. 

The following topics are included in this chapter:

Chapter Topics • Starting GNAV Pro
• About the GNAV Pro Window

Starting GNAV Pro 

Use the following steps to start GNAV Pro.

Step  1 From the Windows desktop, select Start > Programs > NEC > GNAV 
Pro. The GNAV Pro Login dialog box displays (Figure 4-1). 

Figure 4-1  GNAV Pro Login dialog box

Step  2 Enter your User Name, Password and Server Name. Click OK when 
you are done. The GNAV Pro window displays (Figure 4-2). 
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About the GNAV Pro Window 

When you start GNAV Pro, the main window of the application displays 
(Figure 4-2). 

Figure 4-2  GNAV Pro Window

The GNAV Pro window provides access to the real-time statistics, 
reporting tools, and configuration options contained in GNAV Pro. The 
GNAV Pro window contains the menus, toolbar, status bar, and the tree 
view that lists the Entities, Reports, and Views used in GNAV Pro. 

NOTE

For more detailed information regarding GNAV Pro refer to the GNAV Pro Online 
Help system.
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Tree View The Tree View displays in the left pane of the GNAV Pro window and 
contains the Entities, Reports, and Views tabs. The Tree View is 
dockable, allowing you to specify where it appears in the GNAV Pro 
window. Table 4-1 describes the information available in each tab. 

Table 4-1  GNAV Pro Tree View Tabs 

Menus The Menu Bar in the GNAV Pro window Figure 4-2 contains the available 
menus. The Menu Bar is dockable, allowing you to specify where it 
appears in the GNAV Pro window. Table 4-2 describes the menus in 
GNAV Pro. 

Table 4-2  GNAV Pro Menus 

Tab Action
Entities Allows you to view, and when allowed, configure the entities.

Reports Displays the available reports, including the default GNAV Pro 
reports and any custom reports associated with this user account.

Views Displays the available views, including the default GNAV Pro views 
and any custom views associated with this user account.

TIP

You can use your mouse to perform a "drag and drop" procedure and assign an 
agent to a split or to an admin group from within the GNAV Pro main window's tree 
view. You can only use this method if the agent you wish to assign is currently 
logged on. For more information on drag and drop, refer to the GNAV Pro online 
Help system.

Menu Action

File

• Close an open dialog, view, or report.
• Configure printing options.
• Print or preview a view or a report.
• Exit GNAV Pro. 

View • Toggle the display of the toolbar and the status bar. 

Maintenance

• Launch the Real-Time Statistics Wizard, where you can configure 
and generate views.

• Configure the events, wallboards, user accounts. 
• Access Report Designer to create custom report templates.

Report

• Launch the Report Generation Wizard, where you can configure 
and generate reports.

• Configure the data used in reports.
• Maintain Report Sets

Window • Specify the window display options.

Help
• Access the online Help. 
• View the software version and copyright information.
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Toolbar The Toolbar in the GNAV Pro window (Figure 4-2 on page 4-2) provides 
quick access to some of the more common functions. The Toolbar is 
dockable, allowing you to specify where it appears in the GNAV Pro 
window. Table 4-3 below describes the toolbar. 

Table 4-3  GNAV Pro Toolbar 

Toolbar Icon Action

Toggles the Tree View display in the left pane of the GNAV Pro 
window.

Sends the contents of the displayed window to a configured printer.

Creates a print preview of the selected view or report. 

Opens System Configuration where you can configure the entities 
and site informatation.

Opens the Message Sets configuration dialog.

Opens the Access Configuration window, where you can view, add, 
modify, and delete the available user accounts.

Opens the Wallboard Configuration window, where you can view, 
add, modify, and delete the available wallboards and wallboard 
groups.

\
Opens the Real-Time Statistics Wizard, where you can configure 
and generate views.

Opens Report Designer where you can create custom report 
templates.
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Status Bar The Status Bar is located on the bottom of the GNAV Pro window (Figure 
4-2 on page 4-2). The Status Bar displays information about the 
connection to the ACD, PBX, and the Global Navigator Server. 

Launches the Alert Message dialog. This item is also available 
under the Mintenance menu.

Displays all current views (such as Queued Calls, Agent Stats, etc.) 
in separate, external windows (frames). These frames can be re-
sized and positioned on screen as needed.

Returns all external frames to the GNAV Pro main window. The 
frames can then be positioned and tiled or cascaded, as needed.

Toolbar Icon Action
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5
User Configuration

The following topics are included in this chapter:

Chapter Topics • User Configuration Overview
• Accessing User Configuration

User Configuration Overview

Each GNAV Pro user must have a valid User Login and Password on the 
Global Navigator Server before access is granted. The User Access 
window allows an administrator to configure profile information and 
capabilities for GNAV Pro users. Some of the functions available to 
administrators from the User Access window are:

• The ability to add or delete user profiles.
• The ability to configure a user’s name and password.
• The ability to configure a user’s ability to view Admin Groups, Teams, 

Splits, and Reports.
• The ability to configure a user’s permissions. Permissions allow for 

fine-grained control over a user’s capabilities.

NOTE

Only an Administrator has the ability to add users and modify their rights. Users are 
only allowed to give other users access to custom reports and views, and to change 
their own password.
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Accessing User Configuration

Use the following procedure to access the User Access window.

Step Do one of the following:

—Select Configuration > User. 

—Click  on the toolbar. 
The User Access window displays (Figure 5-1). If an Administrator 
access this window, the left tree contains all registered users. If a user 
access this window, only the name of that user displays in the tree.

Figure 5-1  User Access window

NOTE

For more detailed information regarding GNAV Pro refer to the GNAV Pro online 
Help system.
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6
Real Time Statistics Views

This chapter provides an overview of GNAV Pro real-time statistics.

The following topics are included in this chapter:

Chapter Topics • What are Views?
• Real Time Statistics Wizard
• Sorting a View
• Printing Views

What are Views? 

Views are text reports or graphs of real-time statistics that detail call 
state information. You can configure views to include information for any 
entity stored in the GNAV Pro database or data derived from third-party 
source. 

GNAV Pro stores call records in a large number of database tables. Each 
database table is organized into columns and rows. Each column is 
referred to as a field and records an individual detail while the 
associated rows store data for one or more instances of that detail.

Each View is associated with a single database table and the criteria 
specified when creating the View determine the data that is extracted 
from that table and displayed on the screen. As the user, you select 
which fields in the table (i.e. columns) will be displayed in the View. A 
data series consists of an associated row of information across all fields 
(i.e. a record). A View can be constructed of default fields found in the 
GNAV Pro database. You then determine which fields are to be included.

Successfully defining the criteria used to select the data displayed in a 
View can be quite complex and is more suitable for advanced users. 
However, the Real-time Statistics Wizard is designed to assist users in 
defining the data selection criteria used by a View (See “Real Time 
Statistics Wizard” on page 6-3).

NOTE

For more detailed information regarding GNAV Pro refer to the GNAV Pro online 
Help system.
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The Views tab of the GNAV Pro window (Figure 6-1) contains the 
available views. 

Figure 6-1  Navigation Tree - Views tab

The Views tab contains the existing Views organized in a tree view, 
categorized in one of the following folders:

Default Views The Default Views folder contains the standard views available to any 
GNAV Pro user. Default views are pre-configured to contain many of the 
common statistics related to call center activity. Default views can’t be 
modified. Default views include:

• Queued Calls - displays the number of calls in queue on a team or 
split basis.

• Call Stats - displays statistics on call response for the current MIS 
day.

• Agent Stats - displays agent states at the current time. You can use 
the Agent Audit feature in this real time view to display statistics 
about an agent's states throughout the current MIS day.

• State Stats - displays the deployment of agents at the current time 
and cumulative statistics.

• Trunk Groups - displays current statistics for configured trunks, 
including number of calls, calls in queue, calls ringing or busy, and the 
total number of calls.

• GOS Chart - displays a graphic representation of the Grade of Service
• Network ACD - displays current statistics for rerouted calls, longest 

waiting call (LWC), blocked, abandoned, and completed calls.
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Public Views Public views are views that created and saved by one GNAV Pro user for 
use by other GNAV Pro users. When a user changes a View’s 
permissions to public, the View is saved in the Public Views folder, where 
all allowed users can see and modify the View. 

Your Views The views contained in the Your Views folder are views that have been 
created and saved locally by that GNAV Pro user. The views contained in 
this folder can only be seen or modified by that GNAV Pro user.

Context Menu Most functions and configuration settings for views are accessed 
through the shortcut menu that displays when you right-click on a View 
(Figure 6-2). 

Figure 6-2  Real-time Statistics Views Context Menu

Real Time Statistics Wizard

The Real Time Statistics Wizard allows you to create custom real time 
views.

Use the following procedure to access the Real Time Statistics Wizard.

Step Do one of the following:

—Select Maintenance > Statistics Wizard. 

—Click  on the toolbar. 
The first window of the Real Time Statistics Wizard displays 
(Figure 6-3).

NOTE

For detailed instructions regarding GNAV Pro, refer to the GNAV Pro Online Help 
system.
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Figure 6-3  Real Time Statisics Wizard

Sorting a View 

The default views Queued Calls and Agent Stats can be sorted by up to 
the first field (Split/Agent). After opening the view, double click the 
header of the first column, and then all the rows will be sorted 
Ascending up to this column. Double click the header again and the 
rows will sorted Descending.

Printing Views 

You can preview and print an open view in GNAV Pro. Figure 6-4 shows 
a sample view in the Print Preview window.

NOTE

For more detailed information regarding GNAV Pro refer to the GNAV Pro Online 
Help system.
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Figure 6-4  Print Preview window
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7
Reports

The following topics are included in this chapter:

Chapter Topics • Reports Overview
• Creating Custom Report Templates
• Generating Reports
• Creating and Scheduling Report Sets

Reports Overview

GNAV Pro provides many different statistical and configuration reports 
to help you evaluate and tune the performance of the ACD. You can view 
any of the reports from within GNAV Pro, or send them to a configured 
printer.

You can group statistical reports together to create report sets. Then, 
you can schedule each report set to be delivered or printed periodically, 
at a specifed time, or on demand. 

Report Guidelines
Each report can be tailored in hundreds of different combinations. Use 
the following guidelines when producing reports:

NOTE

 NEC does not support the exporting of the report data with Crystal Reports. This is a 
feature of Crystal Reports. The various output formats available are provided by 
Crystal Reports and if used, are to be used entirely at the user's discretion. Also, the 
export of Crystal Reports may result in format and/or alignment inconsistencies when 
compared to the report as viewed using GNAV Pro’s interface. Additionally, some 
formats are not capable of expressing the richness of features provided in the report 
presented with the GNAV Pro interface.

NOTE

For detailed instructions on generating reports, refer to the GNAV Pro Online Help 
system. For detailed information on each available default report , refer to the GNAV 
Pro Reports Manual.
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Subjects
Reports can generate statistical information on the following subjects:

— Agent groupings — either a single group or all splits, teams, admin 
groups, or the entire system

— Individual Agent
— Trunk Groups
— Pilots

You can configure each report using multiple parameters to customize 
its output.

Granularity
Reports have granularity, which is the size of the smallest unit the report 
measures. For example, a report that displays data for each hour in a 
day has a much finer granularity than a report that displays data for 
three 8-hour shifts. GNAV Pro supports the following granularity levels:

— By date — a set of data for each MIS day.
— By shift — a set of data for each shift or all shifts.
— By hour — a set of data for each hour in a range of consecutive 

hours.
You can make the granularity of the by hour option even finer for each 
split by segmenting any hour of the day into smaller units.

Recurrence
You can specify that a report will run automatically, on a schedule you 
select. GNAV Pro supports the following intervals:

— Daily — current day, previous day, or a range of consecutive days.
— Weekly — current week, previous week, or a range of consecutive 

weeks.

— Monthly — current month, previous month, or a range of 
consecutive months.

— Yearly — current year, previous year, or a range of consecutive 
years.

— Days of Week — current day, previous day, or a range of 
consecutive days

You can specify a chronological range by selecting Other in the choice of 
time spans. For example, the user who selects Daily and Other (as 
opposed to Current or Previous) is asked to choose a start date and 
end date for the range.

Report Sets
Reports can be grouped together to construct report sets, which can 
then be scheduled for printing or delivery. Once reports are delivered, 
you can view and work with these reports through the Delivered Reports 
window. 
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Creating Custom Report Templates

You can create custom report templates by using the built-in Report 
Designer. After creating a Custom Report template, you can generate 
the report from the Reports Wizard, or from the Reports tab on the 
GNAV Pro main window.

Report Designer 
Report Designer lets you customize which fields GNAV Pro uses to create 
a custom report. You can also create and customize formulas which 
GNAV Pro will use to display report fields, and add a customized graph 
to present report data visually.

You create a custom report by modifying an existing report template, or 
by creating a new template. Once you create or modify a report 
template, it becomes available in GNAV Pro.

Use the following procedure to access the Report Designer.

Step Do one of the following:

—Select Maintentance > Report Designer. 

—Click  on the toolbar. 
The Report Designer main window displays (Figure 7-1).

Figure 7-1  Report Designer 

NOTE

If you create a custom report graph with more than 30 data points, the resulting 
graph will only show 30 data points on the X-Axis. 



7-4         Reports

Global Navigator Features and Specifications Guide - Revision 2

Custom Report Sample
Figure 7-2 is a sample report created using GNAV Pro’s Report Designer.

Figure 7-2  Custom Report Sample
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Generating Reports

When you generate a GNAV Pro default or custom report, you can 
choose whether to display it on your screen for preview, send it to a 
printer to produce a hard copy, or export it as a file to your computer's 
hard drive.

The Report Wizard allows you to configure and generate default and 
custom Global Navigator reports.

Use the following procedure to access the Report Wizard.

Step Select Report > Generate Report. 

The Report Wizard dialog box displays (Figure 7-3).

Figure 7-3  Report Wizard
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Creating and Scheduling Report Sets

GNAV Pro lets you group statistical reports together to create report 
sets. Each report set can be added to the scheduled set so that it will be 
delivered or printed periodically, at a scheduled time, or on demand. 
Once reports are delivered, you can view and work with these reports 
through the Delivered Reports window (accessible from the Reports Sets 
dialog. 

From the Report Sets dialog, you can create, delete, modify, and 
schedule report sets.

To access the Reports Sets dialog, do the following:

Step Select Reports > Report Sets. 

The login dialog displays (Figure 7-4).

Figure 7-4  Reports Sets 

NOTE

For detailed instructions on scheduling reports, refer to the GNAV Pro Online Help 
system.



   8-1

Global Navigator Features and Specifications Guide - Revision 2

8
Configuring Wallboards

The following topics are included in this chapter:

Chapter Topics • Wallboards Overview
• Creating Wallboard Messages
• Configuring Wallboards

Wallboards Overview 

You can use GNAV Pro to create, edit, schedule, or delete messages 
displayed on wallboards. A wallboard message may contain not only text 
lines, but data elements displaying real-time statistics such as the 
longest waiting call, average speed of answer, grade of service, etc.

GNAV Pro can send real-time statistics to the wallboards which provide 
up-to-the-second information on call center activity. This information 
can be displayed as the events take place, allowing monitoring the 
performance of a specified split or of the call center as a whole.

NOTE

Because wallboard features vary between manufacturers, your wallboard may not 
support some of the procedures described in this section. For specific information on 
features and capabilities of individual models, consult your wallboard manufacturer 
and accompanying documentation.

NOTE

For more detailed information regarding wallboards, refer to the GNAV Pro Online 
Help system.
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Creating Wallboard Messages

The information for display is specified in a Message Set, a series of 
messages: 

• Composed of text and data fields.
• Displayed on a particular Spectrum Wall Display Board type.
• Using colors, graphics, and display modes to convey the information.
The data fields shown in these message sets are the same statistical 
information appearing in the real-time status screens displayed on the 
monitor. The data fields available are based on either split or system 
data.

For a single-line board type, up to 15 messages may be sent (one at a 
time) in the series that makes up the set, and a dual-line board type can 
display a series of 30 messages in a set. The same Message Set may be 
sent to up to four boards of the same type. Only one Message Set may 
be sent to each board at a time.

A Message Set is identified by a set number and a set name, and is 
specified for a particular type of wallboard. The type of board 
determines: 

• How many lines of display are available.
• How many characters an individual message may contain.
• Whether the display can be in up to nine colors or only in red.
The message displayed can be:

• All graphic.
• All user-defined text.
• A combination of user-defined text and data fields.
The mode of display ranges through 25 variations, such as flash, rotate, 
and scroll. Preset graphic displays can be included in the Message Set.

Use the following procedure to access the Message Sets dialog.

Step Do one of the following:

—Select Maintenance > Wallboard Messages. 

—Click  on the toolbar. 
The Message Sets dialog displays (Figure 8-1).
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Figure 8-1  Message Sets dialog

Configuring Wallboards 

Do the following to access the Wallboard Configuration dialog in GNAV 
Pro.

Use the following procedure to access the Wallboard Configuration 
dialog.

Step Do one of the following:

—Select Maintenance > Wallboard Configuration. 

—Click  on the toolbar. 
The Wallboard Configuration dialog displays (Figure 8-2).
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Figure 8-2  Wallboard Configuration dialog

The left tree contains the wallboards and nodes for each network, where 
wallboards can be grouped.

There are 30 wallboards defined by default in the system. The 
wallboards can be grouped into networks, after they have been 
configured. The maximum number of wallboards per network is 10 and 
the defined number of networks is 9 (90-98).

NOTE

For more detailed information regarding wallboards, refer to the GNAV Pro Online 
Help system.
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Appendix A
Database Table Layouts

This appendix provides a description of the database table layouts.

The following topics are included in this appendix:

Appendix Topics • General Information
• Common Statistical Components
• Real-time Statistics Database

General Information 

The GNAV Pro database is the data store for all the information required 
by the application for display and reporting purposes. It is ODBC 
compliant, and supports a multiple security tier.

Components The database’s primary purpose is statistics collection, and it can be 
broken down into major components related to statistics, which are:

— real-time statistics
— summarized statistics
— historical statistics

Terms In these reports:

• Number represents an instantaneous quantity. For example, the 
number of agents in an ACD State would indicate how many agents 
are currently in an ACD State.

• Count represents a figure that was achieved over a period of 
time. For example, ACD State count would indicate a total of how 
many times the ACD State was entered.

• Duration indicates the elapsed time between two events. This 
is stored in seconds.

The following tables list fields and their definitions which apply to the 
statistical components used by the database.



Appendix A - 2         Database Table Layouts

Global Navigator Features and Specifications Guide - Revision 2

Common Statistical Components 

ACD States 
An agent has two line appearances on their extension. The ACD line is 
the line from which all ACD traffic is handled. The ACD line is covered by 
the following states.

Table Appendix A-1  Fields–ACD States

Possible PBX States 
The agent has two line appearances on their extension. The PBX line can 
be in any of the following states. The PBX line supports both incoming 
and outgoing calls.

Table Appendix A-2  Fields–Possible PBX States

Field Definition

Work Being in Work mode but not associated to a call. Possible when the agent enter Wrap-up or After Call 
Work, exits back to Ready and then enters Work mode.

Break 1-9 Any of the 9 defined Break modes. The Break modes may be named in the APPLICATION NAME 
application and reported on individually.

Vacant /Logged Off The agent is no longer servicing any splits. It is now possible for another agent to log on to this extension.

Ready/ Idle The agent has logged on and is ready to accept new calls.

Ringing The agent is being presented with a call from a split the agent is currently logged onto.

Hold A caller on the ACD line has been placed on hold.

Internal The caller is another agent or business station that was received via an ACD queue.

Incoming The caller is an external party that was received via an ACD queue.

Field Definition

Idle The PBX line is currently idle. No calls are being serviced on this line. An agent is logged on to this 
extension, and may currently be using the ACD line.

Vacant /Logged Off The PBX line is currently idle. No calls are being serviced on this line. There are no agents associated 
with this extension.

Incoming The PBX line is being used to answer a call from an external customer.

Internal The PBX line is being used to answer a call from an internal extension.

Outgoing The agent is currently performing an outgoing call or the phone is off-hook.
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Real-time Statistics Database 

Real-time statistics data is updated every time a message is received 
from the PABX. This is the information that will generally be displayed 
directly on the client’s screen. It provides information to the user in two 
distinct forms:

• Current information telling the user what is happening, such as agent 
states and longest waiting call.

• Cumulative data giving information that is a summation of events 
since the MIS start of day, including Count of Incoming Calls, Total 
Break Time, and Grade Of Service.

Key Words Number represents an instantaneous quantity. For example, referring 
to number of agents in an ACD State would indicate how many agents 
are currently in an ACD State.

Count represents a figure that was achieved over a period of time. For 
example, ACD State count would indicate a total of how many times the 
ACD State was entered.

Duration denotes the elapsed time between two events, stored in 
seconds.

All Percentages will be stored to four decimal points. For example, 
80.25% is stored as 0.8025.

Agent 
Agent data is stored in two formats: as a total summary, and per split 
the agent has logged onto. 

Table Appendix A-3  Fields–Agent Real-time Statistics

Field Definition

Agent Logon ID number A unique identifier for this agent. This allows for links to the agent detail record so information such as 
agent name can be obtained.

Agent Name The name of the agent.

Agent Node The node associated to the agent.

Agent Extension The extension the agent is currently logged onto.

Agent ACD State The state the agent (ACD call) is currently in.

Agent ACD time The time that the agent entered the current ACD state.

Agent ACD hold Total number of times that this agent had the call on hold (ACD call).

Agent Queue

Agent PBX State The state the PBX line is currently in

Agent PBX time The time that the PBX line entered the current state

Agent PBX hold Total number of times that this agent had the call on hold (PBX call)
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Split 
All split information is calculated from the moment the call enters the 
split. To find out the time since the call entered the PBX, refer to the 
pilot statistics.

Table Appendix A-4  Fields - Split Real-time Statistics

Field Definition
Split name The name of the split.

Split Id A number that identifies the split from the PBX.

Node The node where the split is positioned.

Total Wait time The total time spent waiting the call to answer in this split.

Total calls Total number of ACD calls.

Total Count ACD incoming Total number of agents in ACD incoming state.

Total Count ACD interna Total number of agents in ACD internal state.

Total Count Work Total number of agents in work state.

Total Count Break Total number of agents in break state.

Total Available agents Total number of agents in available state.

Total Vacant positions Total number of agents in vacant state.

Total Count PBX incoming Total number of agents in pbx incoming state.

Total Count PBX internal Total number of agents in pbx internal state.

Total Count PBX outgoing Total number of agents in pbx outgoing state.

Time ACD incoming Total time spent by the agents in ACD incoming state.

Time ACD internal Total time spent by the agents in ACD internal state.

Time Work Total time spent by the agents in work state.

Time Break Total time spent by the agents in break state.

Time Available Total time spent by the agents in available state.

Time Vacant Total time spent by the agents in vacant state.

Time PBX incoming Total time spent by the agents in pbx incoming state.

Time PBX internal Total time spent by the agents in pbx internal state.

Time PBX outgoing Total time spent by the agents in pbx outgoing state.

Current Count ACD incoming Current number of agents in ACD incoming state.

Current Count ACD internal Current number of agents in ACD internal state.

Current Count Work Current number of agents in work state.

Current Count Break Current number of agents in break state.

Current Available agents Current number of agents in availabe state.

Current Vacant positions Current number of agents in vacant state.
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Current Count PBX incoming Current number of agents in pbx incoming state.

Current Count PBX internal Current number of agents in pbx internal state.

Current Count PBX outgoing Current number of agents in pbx outgoing state.

Average Speed to Answer Average period of time that it took to answer a call presented to this split (calculated by client application)

GOS A percentage of calls answered within a specified period of time

Split LWC The longest period of time a call had to wait that was answered.

Split Pri. Queue Number of calls queued in this split (waiting to be serviced), with this being the primary split (first split 
queued to).

Split Std. Queue Number of calls queued in this split (waiting to be serviced) with this being the secondary split.

Overflow Queue Count the queued overflowed calls.

Agent Queue The number of agents that had queued calls in this split.

No Ann Split Queue The quantity of None Announcements to which queued calls have been connected.

1St Ann Split Queue The quantity of One Announcements to which queued calls have been connected.

2Nd Ann Split Queue The quantity of Two Announcements to which queued calls have been connected.

Abandoned Before Ann Total number of calls that were abandoned in this split before the first announcement

Abandoned After 1St Ann Total number of calls that were abandoned in this split after the first announcement

Abandoned From Ring Total number of calls that were abandoned while receiving ringback tone.

GOS Thresholds If the calls are answered within this time interval, they are counted by GOS.

ASA Alert Level Average Speed Answer threshold level.

LWC Alert Level Longest Waiting Call threshold level.

GOS Alert Level Grade of Service threshold level.

Field Definition
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Team 

Table Appendix A-5  Fields - Team Real-time Statistics

Field Definition
Team Name The name of the team.

Team Id A number that identifies the team from the PBX.

Total Wait time The total time spent waiting the call to answer in this team.

Total calls Total number of ACD calls.

Total Count ACD incoming Total number of agents in ACD incoming state.

Total Count ACD internal Total number of agents in ACD internal state.

Total Count Work Total number of agents in work state.

Total Count Break Total number of agents in break state.

Total Available agents Total number of agents in available state.

Total Vacant positions Total number of agents in vacant state.

Total Count PBX incoming Total number of agents in pbx incoming state.

Total Count PBX internal Total number of agents in pbx internal state.

Total Count PBX outgoing Total number of agents in pbx outgoing state.

Time ACD incoming Total time spent by the agents in ACD incoming state.

Time ACD internal Total time spent by the agents in ACD internal state.

Time Work Total time spent by the agents in work state.

Time Break Total time spent by the agents in break state.

Time Available Total time spent by the agents in available state.

Time Vacant Total time spent by the agents in vacant state.

Time PBX incoming Total time spent by the agents in pbx incoming state.

Time PBX internal Total time spent by the agents in pbx internal state.

Time PBX outgoing Total time spent by the agents in pbx outgoing state.

Current Count ACD incoming Current number of agents in ACD incoming state.

Current Count ACD internal Current number of agents in ACD internal state.

Current Count Work Current number of agents in work state.

Current Count Break Current number of agents in break state.

Current Available agents Current number of agents in availabe state.

Current Vacant positions Current number of agents in vacant state.

Current Count PBX incoming Current number of agents in pbx incoming state.

Current Count PBX internal Current number of agents in pbx internal state.

Current Count PBX outgoing Current number of agents in pbx outgoing state.
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Avg.Spd.Ans. Average period of time that it took to answer a call presented to this team (calculated by client 
application)

GOS A percentage of calls answered within a specified period of time

Team LWC The longest period of time a call had to wait that was answered.

Team Pri. Queue Number of calls queued in this team (waiting to be serviced), with this being the primary team (first team 
queued to).

Team Std. Queue Number of calls queued in this team (waiting to be serviced) with this being the secondary team.

Overflow Queue Count the queued overflowed calls.

Agent Queue Number of agents that had calls queued in this team.

No Ann Team Queue The quantity of None Announcements to which queued calls have been connected.

1St Ann Team Queue The quantity of One Announcements to which queued calls have been connected.

2Nd Ann Team Queue The quantity of Two Announcements to which queued calls have been connected.

Abandoned Before Ann Total number of calls that were abandoned in this team before the first announcement

Abandoned After 1St Ann Total number of calls that were abandoned in this team after the first announcement

Abandoned From Ring Total number of calls that were abandoned while receiving ringback tone.

GOS Thresholds If the calls are answered within this time interval, they are counted by GOS.

ASA Alert Level Average Speed Answer threshold level.

LWC Alert Level Longest Waiting Call threshold level.

GOS Alert Level Grade of Service threshold level.

Field Definition
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Trunk Group 

Table Appendix A-6  Fields - Trunk Group Real-time Statistics

Field Definition
Trunks No The number of trunks in the trunk group.

Idle Trunks The number of trunks in idle state, when no calls have been serviced.

Incoming Trunks The number of trunks in incoming state.

Outgoing Trunks The number of trunks in outgoing state.

Priority Queue The number of priority queued calls in this trunk group.

Standard Queue The number of standard queued calls n this trunk group.

Total Calls The total number of calls in this trunk group.

Total Abandoned Calls The total number of calls in this trunk group that were abandoned.

Total Answered Calls The total number of calls that were answered via this trunk group.

All Busy Trunks The number of times that all trunks were busy.

Trunk Group Number The number which identifies this trunk group in the PBX.

Node The node where this trunk group is positioned.
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Glossary 
ACD Automatic Call Distribution.

Agent A person who logs on to a phone to process ACD calls. An agent has the 
ability to service multiple splits, answering calls from any or all of the 
splits being serviced. An agent may be required to supply a unique ID, 
or an ID may be implied by the agent’s extension.

Agent Group A number of agents grouped to represent different conditions, such as 
experience or skill level. Members of an agent group may be from 
different splits.

Alert A configurable setting which monitors the system’s operation in 
specified critical or non-critical operations, specifying what exactly will 
be monitored and once the once the configured threshold has been 
exceeded, what action to take. The action to take once an alert has been 
triggered is actually an Event of some type (see Event).

ANI Automatic Name Identification (e.g., Caller ID).

CLI Caller Line Identification.

Count (In Report construction) A figure that was achieved over a period of 
time. For example, ACD State count would indicate a total of how many 
times the ACD State was entered.

CTI Computer Telephony Integration. “A term for connecting a computer 
(single workstation or file server on a local area network) to a telephone 
switch (PBX or ACD) and have the computer issue the telephone switch 
commands to move calls around.”

DCOM Distributed Component Object Model (MS). An object-oriented means to 
encapsulate functions and services; platform-independent and 
distributed.

Duration (In Report construction) The elapsed time between two events. This is 
stored in seconds.

Entity A configurable item such as an agent, pilot, or split. Entities represent 
something in the system that is easily identifiable and is a standalone 
element, most likely including a mixture of items created by the system 
without user intervention and items created by the user.

Event An action that can take place at either a scheduled time, or as a result of 
an alarm condition.
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Extension A telephone, generally used for ACD work.

Formula A formula is an expression that could be solved (using an expression 
solver) by any module in the system for the purposes of obtaining  
information about the system’s operation.

GOS Grade of Service.

IVR Interactive Voice Response.

MAT Maintenance Access Terminal, used to configure a PBX and its 
components.

MIS Management Information System.

Node A node is a physical switch. It is also a logical way to group everything 
to do with a given switch, including its agents, splits, pilots, trunks, and 
extensions. Different nodes may be in different locations and time 
zones.

Number (In Report construction) An instantaneous quantity. For example, the 
number of agents in an ACD State would indicate how many agents are 
currently in an ACD State.

ODBC Open Database Connectivity (MS). A standard which allows relational 
and non-relational databases to be accessed by a common interface. 
ODBC drivers use a form of SQL.

Pilot A number used to receive all ACD calls.

Split A queue through which ACD calls are distributed to agents.

Team A group of splits.

SQL Structured Query Language.

Trunk A single incoming or outgoing line from the PBX, uniquely defined with a 
route and circuit number.

Trunk Group A group of trunks based on route numbers.

View A configurable presentation format showing information stored in the 
database or derived information. A View can be configured to show 
information in different types (Report or Graph) for selected entities, 
displaying selected related information.



For additional information or support on this NEC Unified Solutions 
product, contact your NEC Unified Solutions representative.
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